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The Display module allows image data to be reviewed interactively in 2D and 3D. 

The 2D display options allow for the display of the image data in any or all orthogonal planes and also provides the ability to review data in 

any oblique plane. 

The 3D tools provide a variety of display representations for three-dimensional image data sets. Display uses ray casting algorithms to 

rapidly generate volume rendered displays of two classes; Transmission displays (Projections) and Reflections displays (Surface).  

Introduction
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The Display Module interface is 

divided into the following areas: 

[1] Menu, [2] Tools, [3] Display 

Configurations, and [4] Display Area.

Each of these Display Module 

Interface areas are now described:

Display Module Interface
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The Menu provides access to the File, 

Options, and Help menus.  

 

File 
 
The File menu allows users to load 

and save object maps for the loaded 

data set. The File options include:

Input Output Ports: Displays a 
Volume area at the bottom of the 

Display module window. This area 

facilitates the dragging and dropping 

of image data into the module.

Menu
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Load Object Map: When selected 
opens a Load Object Map window 

allowing users to navigate to, select 

and load an object map file. The 

following options are available:

•	 Current Directory: Takes user to 

the current directory, the current 

directory is set by right-clicking in 

the main Analyze 15.0 window and 

then choosing Current Directory 

from the menu. See section 1. 

Analyze Basics for additional 

information. 

•	 Workspace Directory: Takes 

user to the current Workspace 

directory.

•	 Home Directory: Takes user to the 

user’s Home directory. 

•	 Cancel Load: Cancels the load of 

the object map.
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Save Object Map: When selected 
opens a Save Object Map window 

allowing users to navigate to name 

the object map and select a location 

to save the object map file.

Save Object Map As: Allows users 
to save a copy of the current object 

map without overwriting the original 

object map file.

Unload Object Map: Unloads the 
loaded object map

Exit: Closes the module

Options 
 
When selected opens the Options 

menu providing access to Module 

configuration options, including:

Intensities Linked: Allows users to enable or disable linked intensity adjustment. When linked any adjustment an images intensity display 
will be applied to all grayscale slices displayed. When disabled image intensities can be adjusted individually. 
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Zoom Linked: Allows users to enable 
or disable linked zooming. When 

linked any zoom in/out on an image is 

applied to all images. When disabled 

images can be displayed at different 

zoom levels.

Fast Object Rendering: Enables/
Disabled Fast Object Rendering

Show Cursor Coordinates: Allows 
users to Enable/Disable the display 

of the linked cursor coordinates and 

voxel grayscale value displayed in the 

lower left-hand corner of the display 

window.
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Perspective Auto Zoom: The 
Perspective Auto Zoom function is 

used with the Perspective tool. When 

this option is enabled the orthogonal 

view will automatically zoom out so 

the user can see all camera control 

points. 

Auto Note Update: Allows the Auto 
Note Update option to be enabled or 

disabled.

Auto Cursor Link: Allows the Auto 
Cursor Link option to be enabled or 

disabled.

Remember Layout: When enabled the module will remember changes made to the layout and will open with this layout in the future. When 
disabled the module will open with the default layout.

Threads: Allows users to specify the number of threads used in a multi-threaded rendering process. By default, the number of threads is set 
to the number of processors on the system. 

 

Help 
 
The Help menu provides users with quick access to help resources including:.

About: View version, system and environment information.

Users Guide: Opens the Analyze 15.0 User’s Guide.

Get Help: Opens the AnalyzeDirect Support Page.
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Tools 

 

The Tools options provide access to the Toggle Cursor Link, Toggle Region Display and the Set Note State tools. For further information on 

these tools please refer to section 2. Image Display, Controls and Customization. 

Display Area 
 
The Display Area provides access to various display windows and tools, a description of these tools can be found in section 2. Image 

Display, Controls and Customization. However, the Display module offers additional display functionality not found in other modules. These 

tools are described in the following Display Configurations sections. 

Display Configurations 
 
The Display Configuration area allows users to review data in 2D or 3D in the Display Area. The default setting when Display is first opened 

is for the Image(s) check box to be checked which enables the data to be displayed in an array of 2D images. When the 3D checkbox 

is checked, a 3D display window is added to the current display. A myriad of different display options are offered through Display 

Configurations which are now described: 
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Multiple Panels

When Display is first opened, the Image(s) checkbox is selcted by default and the data set will be 

shown as a panel of sections from a single orthogonal orientation. The number of panels shown can be 

controlled using the Columns/Rows button and using the Page Down and Page Up buttons to change 

the number of slices shown. In the lower left-hand corner of the first image there are additional display 

controls tools. These are Orient, Increment, and Slice.

Orient: The Orient tool allows users to switch to switch 
between any of the three orthogonal orientations; Axial, 

Coronal, or Sagittal. Left click on the Orient tool to cycle 

through the orthogonal displays or right-click and choose 

the desired display option from the menu.

Increment: The Increment tool allows users to specify 
the interval used to determine the next image to be 

displayed. Click the yellow Increment text, the cursor will 

update to display an up/down INCR cursor. Hold down 

the left mouse button and slide the cursor upward to 

increase the increment value and downward to decrease 

the increment value.

Slice: Users can navigate through image slices using the slice tool. Click the yellow Slice text in the lower left-hand corner of the image pane. 
An up/down slice cursor will appear. Hold down the left mouse button, and slide the cursor upward to move to a higher slice number and 

downward to move to a lower slice
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All Orientations

Images can be shown as a 3-panel display depicting all orthogonal orientations using the All Orientations option. In this view, the larger 

Primary Panel [1]  can be set to any of the orthogonal orientations by selecting the radio buttons under Primary Panel options  [2]  or by 

double-clicking the desired image.

Thickness: Note that in the lower left-hand corner of each orthogonal display there is a Thickness option. The Thickness tool allows users to 
modify the orthogonal display from one to many slices, displaying a slab of slices in which the average, maximum intensity projection (MIP), 

weighted maximum intensity projection (weighted MIP), minimum intensity projection (MinIP) or weighted minimum intensity projection 

(weighted MinIP) values within the slab thickness (Thick Type) can be displayed. These types of images can improve interpretation accuracy 

and decrease review time.

To adjust display thickness, click the yellow Thickness text, the cursor will update to display an up/down THICK cursor. Hold down the left 

mouse button, and slide the cursor upward to increase the thickness value and downward to decrease the thickness value. Users can also 

right-click and select thickness options calculated based on the data sets volume. 

Thick Type: When the display thickness is increased the Thick Type option is displayed above the Thickness option. Left click on the Thick 
Type text to toggle through the Thick Type options or right-click and choose the desired option from the menu. The Thick Type options are 

shown on the following table:



100

Analyze 15.0 User’s Guide	 © AnalyzeDirect, Inc.

DISPLAY > DISPLAY MODULE INTERFACE

Thick Type Description

Average Average intensity projection displays data using the average values for all voxels in the volume and the thick type 

value for slice integration. This setting can be useful for viewing projections of noisy images, or for simulating a slice 

thickness other than what was scanned.

MIP Maximum intensity projection displays data using only the highest values for each voxel of the volume and the thick 

type value for slice integration.

Weighted MIP After the highest values of each voxel has been determined to be the maximum voxel along the ray path, its value 

is weighted by the percentage of its distance along the ray path.

MinIP Minimum intensity projection displays data using only the lowest values for each voxel of the volume and the thick 

type value for slice integration. This slab mode is particularly useful when looking at air or fluid in smaller slabs of 

slices.

Weighted MinIP After the minimum values of each voxel have been determined to be the minimum voxel along the ray path, its value is 

weighted by the percentage of its distance along the ray path.
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Single Image

The Single Image option shows an image from a single orthogonal orientation, with sequential image display options shown as buttons in 

the lower left of the image display. This is the default display option for loaded movie files. 

In addition to the Thickness, Orient, and Slice display options (discussed earlier) there are video controls for image review, these include: 

Play Reversed: Reverses the direction of the display. Clicking on the tool button again increases the display speed. 

Display previous image: When selected displays to previous image.

Pause: Pauses the display of the images, to continue click on the pause or play button. 

Display Next Image: When selected displays the next image.

Play: Begins the display of the images. Clicking on the tool button again increases the display speed. 

Right-clicking on the controls provides access to additional options including options to change the video controls button size, the option to 

add a delay between the display of images, and an option to automatically reverse display of images at the end.
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Oblique

The Oblique option is only available 

for the All Orientations and Single 

Image Image(s) and all 3-D display 

configurations. When the Oblique 

option is checked [1] it enables the 

display of a new Oblique window 

[2] allowing for the creation of any 

arbitrary plane using the Fly tool 

controls in the Oblique window [3] 

or by adjusting the blue Oblique 

Reference Lines enabled on the three 

orthogonal displays [4]. For further 

information on using the Fly tools 

or the Oblique Reference Lines to 

create oblique images please refer to 

section 6. Transform.
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Additional 2D image display 

parameters are enabled including:

Just Oblique: When selected displays 
just the oblique image.

Perpendiculars: When this option 
is checked [1] additional oblique 

windows are displayed. [2] [3] These 

oblique displays are perpendicular to 

the first oblique image and allow for 

additional manipulations.
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Colormaps

The Display module provides users 

with the ability to create or load a 

colormap over the grayscale image 

data. Options for creating, loading, 

saving, editing, hiding, disabling, and 

removing colormaps are available 

from the right mouse menu for any of 

the 2D image displays. 

Right-click on 2D slice display and 

choose Colormap, a submenu for 

Colormaps will be displayed.

Create: When selected opens the 
Create Colormap window.

•	 Color Cells: allows you to specify 

the number of color cells to be 

used in the creation of the color 

map.

•	 Type: Allows you to specify the 

type of color map to be created, 

choosing from the following:
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•	 Grayscale: Creates a Grayscale 

colormap. 

 

 

 

 

 

•	 Rainbow: Creates a Rainbow 

colormap. 

 

 

 

 

 

•	 Random: Creates a Random 

colormap
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Create: When selected creates 
colormap from specified color cells 

and type. The colormap is applied to 

the displayed image data (1), a color 

bar is displayed (2), and the Edit Color 

Map Window (3) is returned. When 

the Edit Colormap window opens the 

following options are available. 

Action

•	 Select Cell: Allows users to modify 

the color of a specific color cell in 

the colormap.

•	 Use the Index selection arrow 

(1) or the Index field (2) to 

select a color cell.

•	 Adjust the color cell color 

using the RGB input fields (3), 

the HSV input fields (4), or the 

Color Name drop-down (5).
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•	 Draw Cells: When selected allows 

users to draw color channels on 

the interface (1). Color channels 

can be enabled/disabled by 

clicking on the color buttons at 

the bottom of the window (2).

•	 Adjust Bins: Allows users to 

interactively manipulate bins and 

the color ranges of bins. Adjust 

Bins is the default selection.

•	 Bins are indicated by the black 

vertical lines on the color map 

plot. To adjust a bin range, 

select the black control point 

at the top of the vertical black 

bin line (1) and move the line 

to the left or right to increase 

or decrease the bin range.

•	 The Red, Green, and Blue 

color channels can be adjusted 

for each bin. Each color 

channel has a Start point and 

an End point. To adjust select 

the start or end point (2) for a 

color channel and move it up 

or down to adjust.

•	 Apply Changes to Input Data: must be 

selected in order to apply the colormap 

to the image data. If not selected 

before closing the Edit Colormap 

window or adjusting the slice display all 

work on the colormap will be lost.
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•	 Right mouse menu options: Right-clicking in the colormap plot display will reveal 

additional options depending on the current Action selected. These options 

include: .

•	 Delete Bin: When selected deletes the current Bin (available for Adjust Bin 

Action only).

•	 Split Bin: When selected splits the current Bin into two bins (available for Adjust 

Bin Action only).

•	 Set Range: Opens the Set Color Range window allowing users to specify the 

color for a range of color cells.

•	 Start Cell: Specify the starting color cell.

•	 End Cell: Specify the ending color cell.

•	 Set Cell Range to: 

•	 Single Color: Select a single color for the color cell range.  

•	 Fade Between To Colors: Allows users to specify two colors to fade 

between for the specified color cell range 

•	 Start Color: Specify the Starting color. When Single Color is selected this is 

the only option. 

•	 End Color: Specify the Ending color.

•	 OK: Closes the Set Range window.

•	 Apply: Applies the edits to the colormap.
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•	 Reset: Resets the colormap.

•	 Hide Colorbar: Disables/Enables the colorbar on the display of the 2D image

•	 Display Colorbar: Disables the colormap on the grayscale image data. To 

enable the colormap again right-click on the grayscale data and choose 

Colormap and then uncheck Disable Colormap.

•	 Remove: Removes colormap from the image data.

•	 Grayscale: Sets the colormap to a grayscale colormap

•	 Rainbow: Sets the colormap to a Rainbow colormap

•	 Random: Sets the colormap to a Random colormap

•	 Load: Load an existing colormap (.lkup) file (see Load).

•	 Save: Save the current colormamp (.lkup) file.

Load: Allows users to navigate to and load an existing colormap .lkup file. A selection of predefined colormaps can be downloaded from 
analyzedirect.com/data

Save: Saves the current colormap .lkup file.

Edit: Opens the Edit Colormap window.

Hide Colorbar: Disables/Enables the colorbar on the display of the 2D image

Display Colorbar: Disables the colormap on the grayscale image data. To enable the colormap again right-click on the grayscale data 
and choose Colormap and then uncheck Disable Colormap.

Remove: Removes the colormap from the image data.
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Primary Panel

The primary panel option allows any 

of the display images to be set as the 

primary image.

Axial: Makes the axial image the 
primary image. [1]

Coronal: Makes the coronal image 
the primary image.

Sagittal: Makes the sagittal image 
the primary image.

Oblique: Available when the Oblique 
option is selected. Makes the oblique 

image the primary image.

3-D: Makes the current selected 3-D 
display the primary image.
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The 3D checkbox adds a three 

dimensional display window to the 

current collection of displays and 

enables the selection of the type of 

3D visualization depicted in the 3D 

display window.

3D Images
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The Intersecting Sections option 

displays a 3D data set via orthogonal 

section displays. Intersecting 

Sections shows three slices that can 

be controlled using the X/Y/Z values 

in the image display or interactively 

selected by choosing the planes in 

the intersecting sections display.

In the lower left-hand corner of 

the Intersecting Sections display 

window are the Intersecting Sections 

navigation controls.

Intersecting Sections

X: Controls the Sagittal (XZ) slice viewed in the display. Left click the X control option and the cursor will update. Hold down the left mouse 

button and slide the cursor up to increase and down to decrease the X value. Users can also right-click and select First, Middle, or Last.

Y: Controls the Coronal (YZ) slice viewed in the display. Left click the Y control option and the cursor will update. Hold down the left mouse 

button and slide the cursor up to increase and down to decrease the Y value. Users can also right-click and select First, Middle, or Last. 

Z: Controls the Axial (XY) slice viewed in the display. Left click the Z control option and the cursor will update. Hold down the left mouse 

button and slide the cursor up to increase and down to decrease the Z value. Users can also right-click and select First, Middle, or Last. 
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X/Y/Z Right-click options: The three slice display 
controls also provide the following configuration options 

by right-clicking:

•	 Show (X, Y, or Z): Allows users to enable and disable 
the current slice orientation display.

•	 Color Edges: Allows users to enables and disable the 
color edges around the slice displays.

•	 Show Hidden Edges: Only available when Color 
Edges is enabled. Allows users to enable and disable 

hidden edges of the slice displays.

Rot: The Rotation tool, reports the current XYZ rotation 
angle coordinates. When selected, enables the rotate 

cursor. Right-click on the tool to choose from rotation 

default options; Front, Back, Left, Right, Top, Bottom and 

Angled.

Right menu options:

•	 Copy to clipboard: Saves the current Intersecting 
Section image to memory. This can be pasted (Ctrl + 

v) into the Analyze 15.0 workspace, to be saved out of 

the software, or pasted into any other application. 

•	 Save Intersecting Sections: When selected saves a 
recording of the Intersecting Section display to the 

current Analyze 15.0 workspace. 
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Cube Sections shows images on the face of a 

cube representing the data set, with controls to 

select the slices numerically in the window or by 

interactively grabbing an image on the cube. 

The following navigation controls are in the 

lower lefthand corner of the display window:

X: Controls the Sagittal (XZ) slices viewed in the 
display. Left click on the X control to update the 

cursor. Hold down the left mouse button and 

slide the cursor up/down to increase/decrease 

the minimum X value and left/right to increase/

Cube Sections

decrease the maximum X value. Users can also right-click and select Full, 10 %, 25 %, or 33 %.

Y: Controls the Coronal (YZ) slice viewed in the display. Left click on the Y control to update the cursor. Hold down the left mouse button 
and slide the cursor up/down increase/decrease the minimum Y value and left/right to increase/decrease the maximum Y value. Users can 

also right-click and select Full, 10 %, 25 %, or 33 %. 

Z: Controls the Axial (XY) slice viewed in the display. Left click on the Z control to update the cursor. Hold down the left mouse button and 
slide the cursor up/down to increase/decrease the minimum Z value and left/right to increase/decrease the maximum Z value. Users can also 

right-click and select Full, 10 %, 25%, or 33%. 

X/Y/Z Right-click option: Color Edges - Allows users to enables and disable the color edges around the Cube Sections display.

Rot: The Rotation tool, reports the current XYZ rotation angle coordinates. When selected, enables the rotate cursor. Right-click on the tool 
to choose from rotation default options; Front, Back, Left, Right, Top, Bottom and Angled.

Right menu options: Copy to clipboard: copies the current Cube Section image. Save Cube Sections: saves display to the Workspace.
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Wire Grid generates and displays a plot of the 

current slice intensities. Options available are:

Slice: Allows navigation through slices data.

Orient: Allows change of display orientation.

Spacing: Allows different sampling of points in 
the slice for the wire grid display. Small values 

result in fine sampling and large values result in 

coarse sampling. Values in the range of 5 - 10 

are a recommended starting point.

Wire Grid

Xspace: Adjusts the row increment determining which rows of the slice are sampled for the display of the wire grid.

Yspace: Adjusts the column increment determining which rows of the column are sampled for the display of the wire grid. 

Scale: Scale allows for the specification of the display size of the wire grid. The default values are 1. for X and Y and 0.1 for Z.

Xscale: Specifies the x scale used to determine the width of the wire grid.

Yscale: Specifies the y scale used to determine the width of the wire grid.

Zscale: Specifies the z scale used to determine the width of the wire grid.

Rot: The Rotation tool allows users to rotate the display of the wire grid. 

Right mouse menu options: Copy to clipboard: Saves the current wire grid image to memory. This can be pasted (Ctrl + v) into the Analyze 
15.0 workspace, to be saved out of the software, or pasted into any other application. Save Wire Grid: When selected saves a recording of 

the Wire Grid display to the current Analyze 15.0 workspace.
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The Render option enables a 3D 

volume rendering in the 3D display 

window. Display uses ray casting 

algorithms to rapidly generate volume 

rendered displays of two classes; 

Transmission displays (Projections) 

and Reflections displays (Surface).  

Transmission displays (Projections): 
Models the image voxels as light 

emitters and do not involve explicit 

surface detection. A display pixel’s 

value is computed as a function of 

the ray passing through the entire 

volume.

Render

Reflection displays (Surface): Models the image voxels as light reflectors and require the detection of surfaces within the volume. The basic 
reflection algorithms consider the first voxel encountered by the ray which is within the threshold parameters to be the surface voxels to be 

rendered. The algorithms differ in how the detected surface voxels are rendered on the screen. 

By default, a voxel gradient shaded rendering is shown, with controls for threshold selection and rotation angle. Clicking and dragging the 

rendering with the middle mouse button controls the rotation angle. 
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While the tools available for the slice and render display windows are covered in section 2. Image Display, Controls and Customization of 

this user’s guide, the render window in Display has some additional features that are only available to users from the Display module. These 

features will be reviewed in more detail in this section of the guide. 

The display module render window is comprised of several elements and tools: 1) the cursor link tool, 2) the navigation tool, 3) the zoom 

tool, 4) the pan tool, 5) the max/min intensity adjustment tools, 6) the right mouse menu options, and 7) additional rendering controls.

The Display Module Render Window
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The Cursor Link: The cursor link allows users to interactively navigate through the image data. The tool is only enabled if the All 
Orientations, Single Image, or Oblique Image display configurations are enabled, otherwise to the Cursor Link tool is disabled. The Cursor 

Link tool can be controlled from the 3D rendering or from any of the 2D orientations. Moving the tool on the rendering will interactively 

update the orthogonal slice displays. The cursor linked can be enabled or disabled using the Toggle Cursor Link button.

The Navigation tool: The Navigation Icon is not just a reference for the current orientation of the 3D image data, the tool also allows 
users to rotate the data or specify a standard view; front, back, left, right, top, bottom. To rotate the data, left-click on the Navigation Icon 

and hold the left mouse button down. The cursor will update to the rotate cursor enabling interactive rotation of the rendering viewpoint. 

Releasing the left mouse button will dismiss the rotate cursor.

The Zoom tool: The Zoom tool in the Rendering Window allows users to increase and decrease the display size of the data. For more 
information refer to the Zoom tool description in section 2. Image Display, Controls and Customization.

The Pan tool: The Pan tool is automatically enabled when the Zoom size of the image is larger than the current window. Clicking in the tool 
allows users to Pan the zoomed area over the current display.

The Max/Min Intensity Adjustment tool: The Maximum and Minimum display intensities for the rendering can be changed by clicking on 
the yellow Max/Min Tool at the bottom right corner of the window. A cursor will return that allows the values to be manipulated. Hold down 

the left mouse button and move the mouse up/down or left/right.

Right Menu Options: Right-clicking in the Rendering Window reveals additional options. Most of these options, if available, are covered in 
the Slice Display section, however, there are few additional configuration options specific to the Rendering window.

•	 Middle Button Action: Allows action setting of the middle mouse button. See the Slice Display section for additional information. 

•	 Mouse Wheel Action: Allows action setting of the middle mouse wheel. See the Slice Display section for additional information.

The Display Module Render Window (continued)
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Right Menu Options (continued):

•	 Copy to Clipboard: Copies the current rendering display to 
memory.

•	 Hide Colorbar: Allows users to hide or show the colorbar when 
available.

•	 Disable Colormap: Allows users to enable or disable the 
colormap when available.

•	 Cursor Link: Toggles the Cursor Link tool Off/On in the current 
display. 

•	 Interactive Render: Allows users to selects between Reduced 
Quality (useful for interactive rotation of extremely large image 

volumes) and Full Quality.

•	 Object Movement: Object Movement allows users to 
manipulate the location of disabled objects.

•	 Disabled – disable object movements.

•	 Translation – allows X, Y, and Z translations to be applied to 

the selected object.

•	 Rotation - allows X, Y, and Z rotations to be applied to the 

selected object.

The Display Module Render Window (continued)
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Right Menu Options (continued):

•	 Reset ‘Object-x’ Movements – rests all translations and 

rotations for the current object.

•	 Reset All Movements – rests all translations and rotations for 

all objects.

•	 Render Annotations

•	 Volume Edges – when selected draws the volume edges on 

the rendered image.

•	 Clips Edges - when selected draws the clip edges on the 

rendered image.

•	 Back Drop - When selected displays a shaded backdrop in 

the rendered images.

•	 Color – Allows users to change the color of the Volume 

Edges, Clip Edges, or Background Render Annotations, 

when enabled.

•	 Sequencer – allows users to enable the Sequencer tool for 
movie creation (see Sequencer for further information.)

The Display Module Render Window (continued)
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Right Menu Options (continued):

•	 Parametric Mapping – Allows creation of renderings with related parametric maps. When 
the option is selected the Parametric Mapping window opens.

•	 Workspace - allows users to select the workspace containing the related volume to be 

used for parametric mapping.

•	 File - allows users to select the volume to be used for parametric mapping.

•	 Enable Parametric Mapping: Toggles On and Off the mapping of the related volume on 

the rendered surface.

The Display Module Render Window (continued)

•	 Mapping Factor: Allows users to adjust the contribution of the related volume when combining the rendering of the input volumes. 

Increasing the mapping factor provides a clearer display of the related volume. 

•	 Map Transparency Value: Allows users to adjust the transparency value of the related volume.
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Right Menu Options (continued):

•	 Specular Reflection: The Specular Reflection rendering option is available for the 
Gradient Shading, Transparency and Volume Compositing render types. When the 

option is selected the Specular Reflection window opens.

•	 Specular Reflection - Choose from Off or On to determine whether Specular 

Reflection is used to render the volume. Specular Reflection causes the 

highlights on the shiny surface (1). 

•	 Factor - Specifies the percentage of the shading that is done in Specular, 0.00 to 

1.00. The rest of the shading is flat shaded. 

The Display Module Render Window (continued)

•	 Exponent - Controls the falloff rate of the shading. For example, a shiny surface has a high falloff rate, giving a small bright spot. A 

more diffuse surface, has a much lower falloff rate, and thus a lower exponent.
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Right Menu Options (continued):

•	 Lighting: The Lighting options allows users to specifying the location of the light 
source used in reflective renderings. This option is available for the Gradient 

Shading, Transparency and Volume Compositing render types. When selected a 

Lighting window opens providing the following options: 

•	 Horizontal - Specifies the horizontal angle (azimuth) of the light source (in 

degrees) with respect to the viewpoint. 

•	 Vertical - Specifies the vertical angle (elevation) of the light source (in degrees) 

with respect to the viewpoint.  

The Display Module Render Window (continued)

•	 Brightness -  – Specifies the brightness of the light source with respect to the viewpoint.

•	 Save Rendering – saves the current rendering to the Analyze workspace.

•	 Render Options – Allows users to enable/disable additional rendering options, these include:

•	 Show Render Type - Allows users to view and change the rendering algorithm used to render the image data, choose from Depth 

Shading, Gradient Shading (default option), Volume Compositing, Maximum Intensity Projection, Summed Voxel Projection, Surface 

Projections, and Object Compositing. Double click on the Render Type option to cycle through the render types or right-click and 

choose a specific render type from the right mouse menu. For more information about render types and the render type specific 

options please refer to the 3D Rendering section of Display.

•	 Show Rotation - Reports the current XYZ rotation angle coordinates. When selected, enables the rotate cursor. Right-click on the tool 

to choose from rotation default options; Front, Back, Left, Right, Top, and Bottom.
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Right Menu Options (continued): 

•	 Show Threshold: Displays the current Threshold maximum and minimum threshold values. Double clicking allows users to enter 

values. Right click to specify Preset values or choose from Analyze Default, Calculated Max/Min, and DataType Max/Min.

•	 Show Clip Plane: Enables the Clip Plane tool allowing users to specify the maximum and minimum depth along the ray path between 

which voxels are rendered. Clipping is particularly helpful when you need to observe the cross section of a 3D object. 

•	 Show Clip Volume: Enables the Clip Volume tool, allowing users to clip the volume with six clip planes (X low, X high, Y low, Y high, Z 

low, and Z high).

•	 Show Render Size: Displays the current rendering size and allows the user to enter the rendering Width, Height, and Depth. Right 

click to choose from Default, Maximum Diagonal, Double Diagonal, Axial, Coronal, and Sagittal.

•	 Background Color – allows users to set the color of the rendering background. The option opens a Color selection window enabling 
selection of desired color.

•	 Transparency - The Transparency option turns transparent rendering on or off. The transparency rendering mode is useful for visualizing 
objects contained within objects or objects with views obscured by other objects. Object opacity levels can be set using the Opacity 

options in the Object Control window.

•	 Background Opacity - The Background Opacity option is only available when Transparency rendering is enabled. The option allows 
users to specify the background opacity for the transparency rendering. 

•	 Print - Sends capture of current slice display to printer. 

•	 Reset - Resets all options to default.

The Display Module Render Window (continued)
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The additional rendering controls provide access to tools and rendering options only accessible from the Display module:

Type: Allows users to select which type of rendering algorithm to use to create the 3D rendering of the image data. The following Render 
Type options are available: Depth Shading, Gradient Shading, Volume Compositing, Maximum Intensity Projection, Summed Voxel 

Projection, Surface Projection, and Object Compositing. Each type is displayed below and summarized in the table that follows.

Additional Rendering Controls
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Render Type Description

Depth Shading The value of each output pixel is a function of depth only. The depth of the first renderable voxel found along the ray 

path is used to determine the brightness of that voxel. Closer voxels will appear brighter than more distant voxels.

Gradient Shading 

(Default)

The grayscale gradient vector is computed using a 3D neighborhood about the surface voxel. The value projected 

at each output location is the dot product of the gradient vector and an independently specified light source 

vector. This simulates the appearance of a reflective surface under uniform-field illumination.

Volume Compositing Volumetric compositing integrates the gradient-shaded value of all voxels along the ray path. The contribution of 

each gradient-shaded voxel value is weighted by color and opacity values. The color and opacity information for 

each intensity is specified using the Alpha map window.

Maximum Intensity 

Projection

The maximum voxel intensity along the ray path is used.

Summed Voxel 

Projection

The average of all voxels along the ray path is used.

Surface Projection The algorithm searches down the ray for a voxel that is within the current threshold range. Then, it skips the first S 

voxels along the ray, where S is specified by the Surface Skip value. Last, it returns the average of the next T values, 

where T is specified by the Surface Thickness. The surface projection rendering can be limited to enabled objects 

if an object map is loaded.

Object Compositing Available only when an object map is loaded with the data set. Produces 24-bit color renderings where the voxel 

mapping along each ray path is controlled by the Composite Type yellow text.

Display Rendering Types
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Depth Shading

In Depth Shading the value of each 

output pixel is a function of depth 

only. The depth of the first renderable 

voxel found along the ray path is 

used to determine the brightness of 

that voxel. Closer voxels will appear 

brighter than more distant voxels.

Display Rendering Types
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Gradient Shading

In Gradient Shading the grayscale 

gradient vector is computed using 

a 3D neighborhood about the 

surface voxel. The value projected 

at each output location is the dot 

product of the gradient vector and an 

independently specified light source 

vector. This simulates the appearance 

of a reflective surface under uniform-

field illumination.

Display Rendering Types
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Volume Compositing

Volume Compositing (also know as 

Volumetric Compositing) integrates 

the gradient-shaded value of all 

voxels along the ray path. The 

contribution of each gradient-shaded 

voxel value is weighted by color and 

opacity values. The color and opacity 

information for each intensity is 

specified using an Alpha map created 

via the Tissue Map window.

•	 Tissue Map: When the Volume 
Compositing render option is 

selected the Tissue Map option 

is automatically displayed above 

the Type option. A default tissue 

map loaded is loaded and used 

to render the image data. Tissue 

Map Right Click options are as 

follows:

Display Rendering Types
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Volume Compositing (continued)

Right Click Options

•	 Data Tissue Maps: Allows users to select any tissue 

maps previously created and saved for this data type.

•	 User Tissue Maps: Allows users to select any tissue 

maps they may have previously created and saved. 

•	 System Tissue Maps: Allows users to select any system 

tissue maps created, saved and shared by other users. 

Also allows access to the tissue maps distributed with 

the program. 

•	 Palette: Opens the Tissue Map Palette. This window 

provides a preview of the current data with all available 

Data, User, and System Tissue Maps. Double click on 

any of the preview icons to apply that tissue map to the 

image data.

•	 Browse: Allows users to browse the system for tissue 

maps.

Display Rendering Types
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Volume Compositing (continued)

Right Click Options (continued)

•	 Edit: Opens the Tissue Map tool. Double-clicking on the Tissue Map text will also open this tool. 

The Tissue Map tool - provides an interface to allow users to create or edit tissue maps by choosing color and opacity (alpha) values for 
tissue maps. The tool consists of: 1) The parameters area, 2) the colorbar, 3) the parameter display, 4) the tissue list, and 5) the image map.

Display Rendering Types
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Volume Compositing (continued)

The Tissue Map tool (continued)

(1) The Parameters Area: The parameters area allows users to assign color 

and opacity values to ranges of voxels based on intensity. 

•	 To set a range of voxels for the tissue map use the Start/End and Min/

Max controls.

•	 To assign a color to each parameter use the color assignment drop-

down menu or click on the color selector next to the drop-down 

menu.

•	 To adjust the selected tissue opacity level use the opacity drop-down 

menu.

(2) The Colorbar: Displays the tissue maps color bar.

(3) The Parameter Display: Displays an interactive graphical representation 

of the tissue map parameters over a plot of the image histogram.

(4) The Tissue List: Displays the current tissues within the tissue map. •	

To add a tissue, click the ‘+’ key. To remove a tissue, select a tissue and 

then click the ‘-‘ key.

(5) The Image Map: The image map area previews the tissue map 

parameters on the current 2D image. 

Display Rendering Types
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Maximum Intensity Projection

In Maximum Intenstiy Projection the 

maximum voxel intensity along the 

ray path is used. 

Weighting: On/Off - MIP Weighting 
enables the specification of 

performance of weighting.

•	 Off: This is the default state; no 

weighting is applied. 

•	 On: When selected weighting is 

applied. Before the value of the 

voxel is compared to see if it is 

the maximum voxel, its value is 

weighted by the percentage of its 

distance along the ray path.

Display Rendering Types
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Summed Voxel Projection

In Summed Voxel Projection the 

average of all voxels along the ray 

path is used.

Display Rendering Types
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Surface Projection

In Surface Projection the algorithm 

searches down the ray for a voxel that 

is within the current threshold range. 

Then, it skips the first S voxels along 

the ray, where S is specified by the 

Surface Skip value. Last, it returns the 

average of the next T values, where T 

is specified by the Surface Thickness. 

The surface projection rendering can 

be limited to enabled objects if an 

object map is loaded.

•	 Surface Skip: Indicates the 
number of voxels to skip once 

a renderable voxel has been 

detected, before summing of the 

thickness begins.

•	 Surface Thickness: Specifies 
the maximum thickness for the 

rendered surface.

Display Rendering Types
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Object Compositing

Object Compositing is available only 

when an object map is loaded with 

the data set. This rendering option 

produces 24-bit color renderings 

where the voxel mapping along 

each ray path is controlled by the 

Composite Type yellow text.

Composite Type: The following 

composite type options are available.

•	 Transparency - Opacity, Thickness 

and Color parameters for each 

object are used to determine the 

contribution of each visible object 

voxel along the ray path.

Display Rendering Types

•	 Summed Object - The object color contributions for each visible voxel along the ray path are summed and then divided by the total.

•	 Maximum Object - The object which contributes the maximum number of voxels along each ray path is rendered.

•	 Maximum Contiguous Object - The object which contributes the longest contiguous span of voxels along each ray path is rendered.
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Object Compositing (continued)

Object Compositing Options: Surface Shading, Size Scaling, and Position Scaling options are available for certain composite types. These 
options are not available for Transparency. Size and Position Scaling are available for Maximum Contiguous Object methods.

•	 Surface Shading: Adds gradient-based surface shading to the output rendering when this option is enabled.

•	 Size Scaling: The count of voxels belonging to the rendered objects is used to weight the rendered contribution of that object along 

the ray.  Larger counts will be brighter, fewer will be darker.  This provides further visual information in the rendering with respect to the 

relative size of the object along the ray. 

•	 Position Scaling: The output rendering weighted by the relative position of the first voxel rendered for the object along the ray path.  

This provides visual cues to show relative object position, with closer objects being brighter than those occuring later down the ray path.

Display Rendering Types
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Display Rendering Types

Object Compositing (continued)

Rot: Reports the current XYZ rotation angle coordinates. When selected, enables the rotate cursor. Right-click on the tool to choose from 
rotation default options; Front, Back, Left, Right, Top, Bottom and Angled. 

Thresh: The Threshold option displays the current Threshold maximum and minimum values. Editing the threshold values can be useful to 
eliminate noise, airspace, or tissue when an object map has not been loaded.

•	 Clicking the yellow Thresh text will update the cursor to an up/down/left/right Threshold (TRESH) cursor. Hold down the left mouse 

button and slide the cursor forward to increase the minimum threshold value and backwards to decrease it. Slide the cursor right to 

increase the maximum threshold value and left to decrease the maximum threshold value. 

•	 Double clicking the yellow Thresh text allows users to enter minimum and maximum threshold values. 

•	 Right-click to specify Preset values or choose from Analyze Default, Calculated Max/Min, and DataType Max/Min. 
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Display Rendering Types

Object Compositing (continued)

Render Size: The Render Size option allows users to specify various rendering size attributes. The options include: 

•	 Width: Specifies the display width for the rendered image.

•	 Height: Specifies the display height for the rendered image. 

•	 Depth: Specifies the depth for the rendered image.

Right click options:

•	 Default: Sets the width and height to the largest input volume axis. Depth is set to the maximum diagonal (Square Root of the sum of the 

squares of each input axis). 

•	 Maximum Diagonal: Sets the width, height and depth to the maximum diagonal. 

•	 Double Diagonal: Sets the width, height and depth to double the diagonal size. 

•	 Axial: Sets the width and height to the volume’s width and height. The depth is set to the maximum width-depth or height-depth 

diagonal. 

•	 Coronal: Sets the width and height to the volume’s width and depth. The depth is set to the maximum width-height or height-depth 

diagonal. 

•	 Sagittal: Sets the width and height to the volume’s height and depth. The depth is set to the maximum width-height or width-depth 

diagonal.
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Stereo: The Stereo option allows users 
to generate stereo pairs of the current 

rendered image. To enable stereo 

pairs renderings, click on the yellow 

Stereo text or right click and check the 

Stereo option. The following right-click 

options are available:

•	 Red-Blue: Generates a rendering 

for use with “Red-Blue” glasses. 

•	 Red-Green: Generates a rendering 

for use with “Red-Green” glasses. 

•	 Red-Blue: Generates a rendering 

for use with “Red-Blue” glasses.

Display Rendering Types

Object Compositing (continued)

Scale: Enables the specification of scaling factors to be applied to the inputs during the rendering process specifying the size of the 
rendered space. The following options are available:

•	 X: Specifies the X scale factor used to render the X axis, defining the render width.

•	 Y: Specifies the Y scale factor used to render the Y axis, defining the render depth.

•	 Z: Specifies the Z scale factor used to render the Z axis, defining the render height.
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Display Rendering Types

Object Compositing (continued)

Stereo (continued)

•	 Red-Green: Generates a rendering for use with “Red-Green” glasses. 

•	 Cross Fusion: Generates a rendering for use without glasses. The viewer uses a technique of crossing their eyes, looking at the left image 

with the right eye and vice-versa. 

•	 Interlaced: Generates a rendering where every other line comes from each view point. Viewing of this type usually requires an interlaced 

monitor and special glasses which trigger on each frames display.

•	 Disparity: Specifies the angle between the viewpoints. Half for each view point.

•	 Reverse Left/Right: When selected, swaps the viewpoints.

•	 Separation: Available only for Cross Fusion, this value specifies the number of voxels which separate the two centers of the two 

renderings.

Perspective: The Perspective rendering tool allows users to create perspective renderings of the image data based on eye/camera and look 
at viewpoints. The tool can also be used in conjunction with the Sequence tool to create fly-thru movies. Clicking on the yellow Perspective 

text enables Perspective rendering. See the Perspective tool for further information on perspective rendering and movie generation.

•	 Right Click Options

•	 Perspective: Enable or disable perspective rendering.

•	 Perspective Ray Type: Allows users to choose between a floating point or integer ray type for perspective rendering. See Ray Type 

for further information.
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Object Compositing (Continued)

Perspective (continued)

•	 Field Of View: The Field Of View (FOV) 
option allows users to specify the FOV for 

generating perspective renderings. Click 

the yellow Field Of View text and move the 

cursor right to increase the FOV, making 

the rendering appear smaller. Move the 

cursor left to decrease the FOV and the 

rendering appear larger.  Double-clicking 

the yellow Field Of View text allows users 

to manually enter FOV parameters. Right-

clicking on the Field Of View text provides 

access to the following options:

Display Rendering Types

•	 Maintain Aspect: The Maintain Aspect option allows users to disable and enable aspect maintenance. Disabling the Maintain Aspect 

option allows users to specify different X and Y FOV parameters, allowing for the creation of a non-proportional rendering.

•	 Default: Sets the FOV to the default value, approximately a XY FOV value of 25.

•	 Zoom In: When selected decreases FOV, approximately a XY FOV value of 12.5.

•	 Zoom Out: When selected increases the FOV, approximately a XY FOV value of 50.

•	 Zoom Way Out: When selected increases the FOV, approximately a XY FOV value of 70. 
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Object Compositing (Continued)

Ray Type: The Ray Type option allows 
users to switch the ray indexing type 

from Integer to Float. Switching to 

float will improve rendering, however, 

the best results will typically be seen 

with anisotropic data.

Clip Plane: The Clip Plane tool 
allows users to specify the maximum 

and minimum depth along the ray 

between which voxels are processed 

for inclusion in the rendered image. 

Voxels outside the depth range are 

ignored. 

Display Rendering Types

Clicking on the yellow Clip Plane text will update the cursor to display a CLIP cursor. Hold down the left mouse button and slide the cursor 

upwards to increase the Minimum clip value, backwards to decrease the value. Slide the cursor left to decrease the Maximum clip value and 

right to increase the Maximum clip value. Double click on the Clip Plane text to manually enter the minimum and maximum clip values

Right click options:

•	 Half way: When selected sets the minimum clip value to halfway through the data set. 

•	 Reset: Resets the minimum and maximum clip values.
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Object Compositing (Continued)

Clip Plane Right Click Options (cont): Clip Shading: The Clip Shading option specifies the type of shading used, choose from:

•	 Depth: Specifies that a value based only on depth is used to create the shaded pixel.

•	 Actual: Specifies that the gray scale value of the intersected voxel is used.

•	 Gradients: Specifies that the voxel along the ray path, just before the intersected voxel, is temporarily set to the input volume minimum 

intensity value and the gradient shading is calculated.

Display Rendering Types
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Object Compositing (Continued)

Clip Vol: The Clip Volume tool allows 
users to specify a sub-volume of the 

data to be rendered based on the 

X, Y, Z coordinates of the volume. 

Clicking on the yellow Clip Vol text 

will update the cursor to display a 

CLIP cursor and volume edges will 

appear around the rendered image. 

Click on the volume edges to toggle 

through the planes to clip, choosing 

from Low X, High X, Low Y, High Y, 

Low Z and High Z.

Display Rendering Types

Hold down the left mouse button and slide the cursor upwards to increase the plane value, backwards to decrease the value.

Double click the text to manually enter the volume sub-volume parameters:

•	 LX: Low X, specifies the low X value.

•	 HX: High X, specifies the high X value.

•	 LY: Lox Y, specifies the low Y value.
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Object Compositing (Continued)

Clip Vol (continued): 

•	 HY: High Y, specifies the high Y 

value.

•	 LZ: Low Z, specifies the low Z 

value.

•	 HZ: High Z, specifies the high Z 

value.

Clip Vol Right Click Options:

•	 Reset: Resets the minimum and 

maximum clip values.

Display Rendering Types

•	 Clip Shading: The Clip Shading option specifies the type of shading used. Choose from the following options:

•	 Depth: Specifies that a value based only on depth is used to create the shaded pixel.

•	 Actual: Specifies that the gray scale value of the intersected voxel is used.

•	 Gradients: Specifies that the voxel along the ray path, just before the intersected voxel, is temporarily set to the input volume 

minimum intensity value and the gradient shading is calculated.
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The Parametric Mapping functionality 

provides users with the ability to 

blend the rendering of two image 

data sets. This is useful for displaying 

renderings of functional data with 

structural data. A related data set is 

loaded via the Parametric Mapping 

window available from the right 

mouse menu in the Render window. 

The related image must be registered 

with the base data set beforehand in 

order for it to be used as a parametric 

input volume.

Download the MRI_Brain.avw and the 

PET_Brain.avw to follow along from

Parametric Mapping

https://analyzedirect.com/data. Use the Input/Output module to load both the MRI_Brain.avw and the PET_Brain.avw data sets. Select the 

MRI_Brain data set and then open Display. In Display set the Display Configuration to 3-D and choose the Render option (1). Uncheck the 

Image(s) option. 

Change the orientation of the brain to right using the Navigation icon (2). Right-click in the Render window and choose Parametric Mapping 

from the menu options (3).

In the Parametric Mapping window choose the PET_Brain data set from the File drop down (4). If the data resides in another Workspace 

select that workspace using the Workspace drop down. Alternatively, drag-and-drop the related image from the workspace onto the 

Parametric Mapping window.
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The Parametric rendering will be 

displayed.

Adjust the Mapping Factor and 

observe the effect on the rendering.

Parametric Mapping (Continued)
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Creating a Basic Movie

The Sequence tool provides users 

with an intuitive interface to quickly 

create impressive movies of the 

rendered image data. 

Download the Mouse_Lungs.avw 

data set to follow along, from https://

analyzedirect.com/data.•

Use the Input/Output module to load 

the Mouse_Lungs.avw.

Select the Mouse_Lungs data set and 

then open Display.

Sequence Tool

In Display set the Display Configuration to 3-D and choose the Render option. Uncheck the Image(s) option. (1)

Right-click in the Render window and select Sequencer from the menu (2). The Sequencer tool will be displayed below the rendering. (3)

Click the Add Key Frame button (4) to add a starting key frame to the sequencer (5).
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Double-click the Yellow Thresh text 

in the lower left-hand corner of the 

Render window and change the 

minimum value to 2200 (6). Note the 

updated rendering. (7).

Click the Add Key Frame button 

(8) to add a new key frame to the 

sequencer (9).

Left click the Transition button (10) 

between the key frames to open the 

Transition parameters window (11), 

here set the number of Frame(s) to 30 

(12).

Sequence Tool (continued)

Click the Preview Sequence button (13) to preview the movie.

To save the movie to the Analyze workspace select Generate and Save. (14).

In the Window returned name the movie (15) and then select Render Sequence 

(16). The movie file will be saved to the workspace. Use the Input/Output 

module to save the movie out of the software as an .AVI, QuickTime, or 

Animated GIF.
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Creating a Rotational Movie

Download the Mouse_Lungs.avw and 

the Mouse_Lungs.obj files to follow 

along, from https://analyzedirect.com/

data

Use the Input/Output module to load 

the Mouse_Lungs.avw.

Select the Mouse_Lungs data set and 

then open Display.

Select File > Load Object Map and 

load the Mouse_Lungs.obj.

In Display set the Display 

Configuration to 3-D and choose

Sequence Tool (continued)

the Render option (1). Uncheck the Image(s) option.

Right-click on the Rendering and then choose Transparency from the menu.

After Transparency has been applied right click again and select the Sequencer option (2).

The Sequencer tool will be displayed below the rendering (3)
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To create a simple rotational movie, click the Add Key Frame button (4) twice to add two 

key frames to the sequencer (5).

Left click the Transition button between the key frames (6) to open the Transition 

parameters window (7).

In the Transition window set the number of Frames to 20 (8), next check the 360 Rotation 

option (9) and then select Screen Y (10).

Select the Preview Sequence button to review the movie (11).

To save the movie to the Analyze workspace select Generate and Save. (12)

In the Window returned, name the movie and then select Render Sequence. The movie 

file will be saved to the workspace. Use the Input/Output module to save the movie out 

of the software as an .AVI, QuickTime, or Animated GIF.

Sequence Tool (continued)
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Enhanced Movie Making: Object 
Movement and Rotation

Download the Mouse_Lungs.avw and 

the Mouse_Lungs_2.obj files to follow 

along, from https://analyzedirect.com/

data

Use the Input/Output module to load 

the Mouse_Lungs.avw.

Select the Mouse_Lungs data set and 

then open Display.

Select File > Load Object Map and 

load the Mouse_Lungs_2.obj.

Sequence Tool (continued)

In Display set the Display Configuration to 3-D and choose the Render option (1). Uncheck the Image(s) option. 

Right click in the Render window and select the Sequencer option.

The Sequencer tool will be displayed below the rendering, click the Add Key Frame button (2) to add a starting key frame to the sequencer.

Next, right-click on the in the Render window and choose Object Movement > Translation (3).
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Click on the left lung object to select it and then 

drag it to the right (4). When complete click Add 

Key Frame (5).

Click Transition button between the two key 

frames to open the Transition parameters window 

(6), set the Frame(s) to 20.

Click Preview Sequence to preview the movie so 

far. 

Next, press the Shift key and then select the left 

lung, the Object Transformation will be changed 

from a translation to a rotation, rotate the left lung 

(8).

When complete click Add Key Frame, note that 

the transition is automatically set to 20 frames (9).

Click Preview Sequence to preview the movie so 

far.

Sequence Tool (continued)
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Next, let’s perform the translation and rotation on 

the right lung in one key frame. Click on the right 

lung object to select it and then drag it to the left. 

(10) Press the Shift key and select the right lung 

again, rotate the right lung (11).

When complete click Add Key Frame, again the 

transition is automatically set to 20 frames (12).

Click Preview Sequence to preview the movie 

so far. The movie will show the left lung moving 

out the right side followed by a rotation, next 

the left lung will move out to the left side while 

performing a rotation. 

Now let’s add a rotation. Click the Add Key Frame 

button again to add a new key frame, click on 

the Transition button added before the last key 

frame (13). In the Transition window check the 360 

Rotation option and choose Screen Y (14).

Sequence Tool (continued)
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To end the movie, let’s have all 

objects move back to their original 

positions. You could achieve this by 

right-clicking on the Render window 

and choosing Object Movement > 

Reset All Movements. However, in 

this case we will copy the first key 

frame and paste it to the end of the 

sequence we have generated. 

Right-click on the first key frame and 

choose Copy from the menu (15).

Right-click at the end of the sequence 

and choose Paste (16) to paste a copy 

of the first key frame and the end (17).

Sequence Tool (continued)

This provides a nice movie that starts and ends with the all objects in the same position, important for when looping the movie for a 

presentation.

Preview the movie and then use the Generate and Save option to save a copy to the workspace. 

Explore the other rendering options to help enhance your movies, for example use the Scale option to give the effect of zooming in or out 

of your rendered image and use the Clip Plane or Clip Volume options to clip into the data.
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Enhanced Movie Making: Zooming 
and Clipping

Download the Mouse_Lungs.avw and 

the Mouse_Lungs_2.obj files to follow 

along, from https://analyzedirect.com/

data

Use the Input/Output module to load 

the Mouse_Lungs.avw.

Select the Mouse_Lungs data set and 

then open Display.

Select File > Load Object Map and 

load the Mouse_Lungs_2.obj.

Sequence Tool (continued)

In Display set the Display Configuration to 3-D and choose the Render option (1). Uncheck the Image(s) option. 

Right click in the Render window and select the Sequencer option.

The Sequencer tool will be displayed below the rendering, click the Add Key Frame button (2) to add a starting key frame to the sequencer.

If the additional rendering options are not visible in the lower left hand corner of the Render window (3) enable the options by right-clicking 

in the Render window and then choosing Render Options from the menu, check the Show Scale and Show Clip Plane options, but feel free 

to enable all options (4).
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Double click the yellow Scale text and change the 

X, Y, and Z Scale values to 2.2 (5). Note that the 

rending display size will increase. 

Click Add Key Frame (6) to add a new key frame to 

the sequence.

Click the Transition button (7), in the Transition 

parameters window (8) set Frame(s) to 25 (9).

Double click the yellow Clip Plane text and change 

the Min value to 642. (10) Note that the rendering 

display will be clipped.

Click Add Key Frame (11) to add a new key frame 

to the sequence.

Click the Transition button and increase the 

number of Frame(s) to 50 (12).

Sequence Tool (continued)
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Double click the yellow Clip Plane text and change 

the Min value back to 1. (13) Note that the rending 

display will update.

Click Add Key Frame (14) to add the new key 

frame to the sequence.

Double click the yellow Scale text and change the 

X, Y, and Z Scale values back to 1. (14) Note that 

the rending display size will decrease. 

Click Add Key Frame (15) to add the new key 

frame to the sequence.

Click Preview Sequence (16) to preview the movie.

Click Generate and Save (17) to save the movie to 

the workspace.

Sequence Tool (continued)
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The Perspective Tool provides 

users with another option to create 

powerful and interesting movies from 

their rendered image data. 

Download the EGV_CT.avw data 

set to follow along, from https://

analyzedirect.com/data.

Use the Input/Output module to load 

the EGV_CT.avw.

Select the EGV_CT data set and then 

open Display.

In Display check both the Image(s) 

and 3-D Display Configuration

Perspective Tool

options. Make sure to choose All Orientations and Render.

From the Render options in the lower left-hand corner double click on the yellow Thresh text and change the Min value to 430. (2) Note if 

the Render options are not available right click in the Render window and choose Render Options, enable all the options.

Right click on Type and select Volume Compositing. (3) Then right click on Tissue Map and choose System Tissue Maps > CT 2 (4).

Enable the Perspective tool by clicking on the Perspective option changing it from disabled to enabled. (5) Note that the three orthogonal 

views will update to display interactive camera and look at points. Right click in the Render window and choose Sequencer (6) to enable to 

sequencer below the Render window. Click Add Key Frame to add a starting key frame to the sequencer (7).
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In the Sagittal orientation click on the perspective camera point (round icon) (8) and move it to the left (9).

Perspective Tool (continued)

Note the update to the rendering 

(10).

Click the Add Key Frame button 

(11) to add the new key frame to the 

sequence. Click the Transition button 

(12) and set the Frame(s) to 25 (13).
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In the Axial orientation, zoom in to view the display clearer. (14). Select the perspective Camera point (15) and move it clockwise (16). 

Perspective Tool (continued)

Note the update to the rendering 

(17).

Click the Add Key Frame button 

(18) to add the new key frame to the 

sequence. 
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In the Coronal orientation click on the perspective camera point (19) and move it left, closer to the image data (20).

Perspective Tool (continued)

Note the update to the rendering (21). 

Click the Add Key Frame button (22) to 

add the new key frame to the sequence. 

Right click on the first frame and choose 

Copy (23). At the end of the sequence 

right click and choose Paste. (25) The 

movie will now start and end at the same 

point.

Preview the movie (26). If you wish 

to save the movie sequence to apply 

to another data set, right-click in the 

Sequencer and choose Save Sequence. 

(27). To save the movie to the workspace 

select Generate and Save (28).


